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Tuotteiden saatavuus voi vaihdella alueittain. Saat lisätietoja lähimmältä Nokia-
jälleenmyyjältä.
Joissakin paikoissa voi olla Bluetooth-tekniikan käyttöä koskevia rajoituksia. Tarkista asia 
paikallisilta viranomaisilta tai palveluntarjoajalta.
Tämä laite saattaa sisältää hyödykkeitä, tekniikkaa tai ohjelmia, joihin sovelletaan 
Yhdysvaltojen ja muiden maiden vientilakeja ja -määräyksiä. Käyttäjän tulee noudattaa 
tällaisia lakeja ja määräyksiä.
9242022/3. painos FI/Internet Tablet 2005 ohjelmistoversio
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Turvallisuutesi vuoksi

Lue nämä ohjeet. Ohjeiden vastainen käyttö saattaa olla vaarallista tai 
lainvastaista. Saat lisätietoja lukemalla koko oppaan.

KYTKE VIRTA LAITTEESEEN TURVALLISESTI
Älä kytke laitteeseen virtaa silloin, kun langattoman laitteen käyttö 
on kielletty tai se voi aiheuttaa häiriöitä tai vaaratilanteen.

LIIKENNETURVALLISUUS
Noudata kaikkia paikallisia lakeja. Pidä kädet aina vapaina, jotta voit 
hallita ajoneuvoa sitä ajaessasi. Aseta ajaessasi ajoturvallisuus 
etusijalle.

HÄIRIÖT
Kaikki langattomat laitteet ovat alttiita häiriöille, jotka voivat 
vaikuttaa laitteiden toimintaan.

SULJE LAITE SAIRAALASSA
Noudata kaikkia rajoituksia. Sulje laite lääketieteellisten laitteiden 
lähellä.

SULJE LAITE ILMA-ALUKSISSA
Noudata kaikkia rajoituksia. Langattomat laitteet voivat häiritä ilma-
aluksen järjestelmien toimintaa.

SULJE LAITE TANKATESSASI
Älä käytä laitetta huoltoasemalla. Älä käytä sitä polttoaineen tai 
kemikaalien läheisyydessä.

SULJE LAITE RÄJÄYTYSTYÖMAALLA
Noudata kaikkia rajoituksia. Älä käytä laitetta räjäytystyömaalla. 

KÄYTÄ JÄRKEVÄSTI
Käytä laitetta vain normaaliasennossa laitteen käyttöohjeiden 
mukaisesti.

VALTUUTETTU HUOLTO
Vain valtuutettu huoltoliike saa asentaa tai korjata tuotteen.

LISÄLAITTEET JA AKUT
Käytä vain hyväksyttyjä lisälaitteita ja akkuja. Älä yhdistä 
yhteensopimattomia tuotteita toisiinsa.
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VEDENKESTÄVYYS
Laitteesi ei ole vedenkestävä. Pidä se kuivana.

VARMUUSKOPIOT
Muista tehdä varmuuskopiot tai pitää kirjaa kaikista tärkeistä 
tiedoista.

YHDISTÄMINEN MUIHIN LAITTEISIIN
Kun yhdistät tuotteen johonkin toiseen laitteeseen, lue tarkat 
turvaohjeet laitteen käyttöohjeesta. Älä yhdistä yhteensopimattomia 
tuotteita toisiinsa.

■ Tietoja laitteesta
Kun käytät tämän laitteen toimintoja, noudata lakeja ja kunnioita muiden 
yksityisyyttä ja muita oikeuksia. 

Varoitus: Laitteen on oltava päällä, jotta sen toimintoja voidaan 
käyttää. Älä kytke laitteeseen virtaa silloin, kun langattoman laitteen 
käyttö voi aiheuttaa häiriöitä tai vaaratilanteen.

■ Verkkopalvelut
Palveluntarjoaja antaa tarvittaessa lisätietoja verkkopalvelujen käytöstä ja niihin 
liittyvistä maksuista. Joissakin verkoissa voi olla rajoituksia, jotka vaikuttavat 
verkkopalvelujen käyttöön.
Palveluntarjoajasi on voinut pyytää, että jotkin laitteesi toiminnot poistetaan 
käytöstä tai että niitä ei aktivoida. Laitteeseesi on myös voitu määrittää 
erityisasetuksia.

■ Jaettu muisti 
Seuraavat laitteen toiminnot voivat käyttää jaettua muistia: kirjanmerkit, kuva-, 
ääni- ja videotiedostot, huomautus-, luonnos- ja muut tiedostot, 
sähköpostiosoitekirjan yhteystiedot, sähköpostiviestit ja -sovellukset. Näitä 
toimintoja käytettäessä muistia voi olla vähemmän muita jaettua muistia 
käyttäviä toimintoja varten. Esimerkiksi usean kuvan tallentaminen voi viedä 
koko käytettävissä olevan muistin. Laitteen näyttöön voi tulla täydestä muistista 
kertova ilmoitus, kun yrität käyttää jaettua muistia käyttävää toimintoa. Poista 
tällöin osa jaettuun muistiin tallennetuista tiedoista, ennen kuin jatkat.
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1. Yleistä tietoa

Nokia 770 Internet Tablet -kämmenselaimen avulla voit muodostaa 
Internet-yhteyden ja käyttää medioita langattoman lähiverkkoyhteyden 
(WLAN) tai langatonta Bluetooth-tekniikkaa tukevan matkapuhelimen 
avulla. Laitteessa on myös monia muita sovelluksia, kuten sähköposti ja 
audiosoitin.

Nokia 770 Internet Tablet -kämmenselaimen mukana toimitetaan 
ohjauskynä, jolla hallitaan laitteen käyttöliittymää, ja 
tallennusvälineenä toimiva pienikokoinen multimediakortti.

Lue tämä käyttöohje huolellisesti ennen laitteen käyttämistä. Lue myös 
laitteen mukana toimitettu pikaohje ja yhteensopivan Nokia-puhelimen 
käyttöohje, joissa on tärkeitä turvallisuus- ja huoltotietoja. 

Kun haluat muodostaa Internet-yhteyden langattoman lähiverkon 
avulla, lue yhteensopivan WLAN-liityntäpisteen mukana toimitetut 
ohjeet. Liityntäpisteen on oltava yhteensopiva IEEE 802.11b- tai IEEE 
802.11g -standardin kanssa.

Tässä tuotteessa käytetään Linux-pohjaista Internet Tablet 2005 
ohjelmistoversiota.

■ Nokia-tuki Web-sivustossa
Tämän oppaan viimeisimmän version, lisätietoja, ladattavia ohjelmistoja 
ja Nokia-tuotteeseesi liittyviä palveluja löydät osoitteesta 
www.nokia.com/support tai paikallisesta Nokian Web-sivustosta.
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2. Käytön aloittaminen

■ Suojakuoren 
poistaminen

Laitteen mukana toimitetaan kuori, 
joka parantaa kosketusnäytön 
suojausta.

Kun haluat poistaa kuoren laitteen 
päältä, työnnä sitä nuolen suuntaan.

Kun haluat asettaa kuoren takaisin 
paikalleen, työnnä laite kuoren 
sisälle niin, että kosketusnäyttö jää 
näkyviin ja laitteen pohja osoittaa 
kuoressa olevaan aukkoon päin.

■ Akun asentaminen
1. Paina akun kannessa olevaa 

painiketta ja työnnä kansi 
laitteesta (1).

2. Kohdista akun kullanväriset 
liitinpinnat laitteessa olevien 
liittimien kanssa ja paina akun 
vastakkainen pää laitteeseen (2).

3. Työnnä akun kantta takaisin 
laitteeseen, kunnes kansi 
napsahtaa paikalleen.

Katkaise aina laitteesta virta ja 
irrota laturi ennen akun 
poistamista.

■ Akun lataaminen
Tarkista laturin mallinumero ennen 
sen käyttöä tämän laitteen kanssa. 
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Tämä laite on tarkoitettu käytettäväksi vain Nokia AC-4- ja DC-4 -
latureiden kanssa.

Varoitus: Käytä vain sellaisia akkuja, latureita ja lisälaitteita, 
jotka Nokia on hyväksynyt käytettäväksi tämän mallin kanssa. 
Muuntyyppisten tuotteiden käyttö voi tehdä siitä hyväksynnän 
vastaisen tai mitätöidä laitetta koskevan takuun ja saattaa olla 
vaarallista.

1. Kytke laturi verkkopistorasiaan.

2. Kytke virtajohto laitteen pohjassa 
olevaan laturin liittimeen. Akun 
latauksen ilmaisinpalkki alkaa 
rullata näytöllä. 

Voit käyttää laitetta sen latauksen 
aikana. Kun akku on latautunut 
täyteen, palkki lakkaa rullaamasta. 

Tietoja hyväksyttyjen lisälaitteiden saatavuudesta saat laitteen 
myyjältä. Kun irrotat lisälaitteen virtajohdon, ota kiinni ja vedä 
pistokkeesta, älä johdosta.

Lisätietoja on kohdassa "Tietoa akuista" sivulla  45.

■ Muistikortin asentaminen
Laitteen mukana toimitetaan pienikokoinen multimediakortti (RS-
MMC) ja sovitin. RS-MMC-multimediakortti on pienempi kuin 
täysikokoinen MMC-kortti. Tässä laitteessa voi käyttää vain FAT 16/32 -
alustettuja muistikortteja.

Käytä vain tämän laitteen kanssa yhteensopivia pienikokoisia 
multimediakortteja (RS-MMC). Muut muistikortit, kuten Secure Digital 
(SD) -kortit, eivät sovi muistikorttipaikkaan eivätkä ole yhteensopivia 
tämän laitteen kanssa. Yhteensopimattoman muistikortin käyttö voi 
vahingoittaa muistikorttia ja laitetta, ja yhteensopimattomalle kortille 
tallennetut tiedot voivat vioittua.
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Muistikortti asennetaan seuraavasti:

1. Kun näyttö on alaspäin, vedä muistikorttipaikan luukkua 
sormenpäällä (1) ja kierrä luukku ylös (2).

2. Aseta muistikortti niin, että viistottu nurkka osoittaa liittimiin päin 
ja kullanväriset liitinpinnat osoittavat alaspäin.

3. Työnnä muistikorttia varovasti korttipaikkaan, kunnes muistikortti 
lukittuu paikalleen (3).

4. Kun haluat sulkea luukun, kierrä se takaisin muistikorttipaikan päälle 
ja työnnä sitä korttipaikkaan, kunnes luukku napsahtaa paikalleen. 
Muistikorttia ei voi käyttää, jos luukkua ei ole suljettu kunnolla.

Kun haluat poistaa muistikortin, avaa muistikorttipaikan luukku ja 
työnnä korttia, kunnes se ponnahtaa korttipaikasta. Sulje luukku.

Laite käyttää hot swap -tekniikkaa, joten muistikortin asentaminen ja 
poistaminen virran ollessa kytkettynä laitteeseen eivät häiritse 
järjestelmän toimintaa. 

Tärkeää: Älä poista MMC-korttia minkään korttia käyttävän 
toiminnon aikana. Kortin poistaminen kesken toiminnon voi 
vahingoittaa muistikorttia ja laitetta, ja kortille tallennetut 
tiedot voivat vioittua.
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■ Virran kytkeminen ja 
katkaiseminen

Kun haluat kytkeä laitteeseen virran tai 
katkaista sen siitä, pidä virtanäppäintä 
alaspainettuna.

Jos laite kysyy suojakoodia, näytöllä näkyy 
kehotus Enter lock code. Anna suojakoodi 
(5 - 10 merkkiä) virtuaalinäppäimistön 
avulla ja kosketa OK-kuvaketta. Kun haluat 
poistaa väärän numeron, kosketa -kuvaketta. Oletusarvoisesti 
laitteen lukitus on poissa käytöstä.

Oletussuojakoodi on 12345. Lisätietoja koodin muuttamisesta ja 
laitteen automaattisen lukituksen käyttöönotosta on kohdassa 
"Laitteen suojaus" sivulla  22.

Huomautus: Jos kadotat laitteen suojakoodin, vie laite 
valtuutettuun  Nokia-huoltoliikkeeseen. Lukituksen avaamiseksi 
ohjelmisto on ladattava laitteeseen uudelleen, minkä 
seurauksena kaikki laitteeseen tallentamasi tieto voi hävitä.

3. Laitteesi

■ Näkymä edestä ja ylhäältä
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Laitteessa on seuraavat näppäimet ja osat:

• Kosketusnäyttö (1)

Kun haluat käyttää laitetta, kosketa näyttöä ohjauskynällä.

Huomautus: Näytöstä saattaa puuttua jonkin verran pisteitä, 
tai pieni määrä niistä voi olla värjäytyneitä tai kirkkaita. Tämä 
on tyypillistä tällaiselle näytölle. Joissakin näytöissä saattaa olla 
aina päällä tai poissa päältä olevia pikseleitä tai pisteitä. Tämä 
on normaalia, eikä se ole vika.

• Virtanäppäin (2)

• Suurennus- ja pienennysnäppäin (3)

• Kokonäyttönäppäin (4)

• Kaiutin (5) 

Varoitus: Älä pidä laitetta korvallasi kaiuttimen käytön aikana, 
koska äänenvoimakkuus voi olla erittäin suuri. 

• Selausnäppäin (6)

• Escape-näppäin (7)

• Valikkonäppäin (8)

• Aloitusnäppäin (9). Lisätietoja on kohdassa "Laitteen näppäimet" 
sivulla  18.

■ Näkymä pohjasta ja oikealta sivulta
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• Laturin liitin (1) Nokia AC-4- tai DC-4 -latureille.

• Mini USB -portti (2) laitteen mukana toimitetulle Nokia DKE-2-
liitäntäkaapelille.

• Stereoäänen ulostuloliitin (3), jolla laitteeeseen voi liittää 
yhteensopivat 3,5 mm:n pistokkeella varustetut kuulokkeet. Äänen 
ulostuloliitin on yhteensopiva kuulokkeiden kanssa, joiden 
näennäisvastus on vähintään 16 ohmia.

• Työnnä ohjauskynä pidikkeestään (4), jossa sitä säilytetään silloin, 
kun sitä ei käytetä. Muista asettaa ohjauskynä takaisin paikalleen 
kärki edellä.

Tärkeää: Käytä vain ohjauskynää, jonka Nokia on hyväksynyt 
käytettäväksi tämän laitteen kanssa. Muunlaisen ohjauskynän 
käyttö voi mitätöidä laitetta koskevan takuun ja vahingoittaa 
kosketusnäyttöä. Vältä naarmuttamasta kosketusnäyttöä. Älä 
koskaan kirjoita kosketusnäyttöön oikealla kynällä tai muulla 
terävällä esineellä.

■ Kosketusnäyttö

Kosketusnäytön osat ovat tehtävärivi (1), sovelluksen otsikkoalue (2), 
tilanilmaisinalue (3), pienennys- ja sulkemispainikkeet (4), sovellusalue 
(5) ja työkalurivi (6).
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Tehtävärivi
Tehtävärivillä (1) on kuvakkeita, joita koskettamalla voit avata eri 
sovelluksia, aloittaa uusia tehtäviä ja käyttää kirjanmerkkejä.

Kun haluat valita vaihtoehdon, kosketa sitä ohjauskynällä. Voit myös 
selata haluamaasi valikkovaihtoehtoon ja avata sen painamalla 
selausnäppäimen keskiosaa. Kun haluat sulkea valikon, paina Esc-
näppäintä tai kosketa jotain muuta näytön aluetta.

Tehtävärivillä on seuraavat osat:

Web-selain – Kosketa -kuvaketta, kun haluat avata valikon, jossa on 
Internet-toimintoja. Niiden avulla voit avata uuden selainikkunan, 
käyttää kirjanmerkkejä tai avata kirjanmerkkisovelluksen. Lisätietoja on 
kohdassa "Web-selain" sivulla  31.

Sähköposti – Kosketa -kuvaketta , kun haluat avata valikon, jossa on 
sähköpostitoimintoja. Niiden avulla voit luoda uuden sähköpostiviestin, 
käyttää yhteystietoja ja lähettää sekä vastaanottaa sähköpostia. 
Sähköpostikuvakkeen ulkonäkö määräytyy sähköpostiyhteyden tilan 
mukaan: Lisätietoja on kohdassa "Sähköposti" sivulla  33.

Muut sovellukset – Kosketa -kuvaketta, kun haluat avata valikon, 
jonka avulla voit käyttää muita sovelluksia, kuten mediasoittimia ja 
katseluohjelmia, apuohjelmia ja pelejä. Lisätietoja on tämän 
käyttöohjeen vastaavissa osissa ja kunkin sovelluksen ohjeessa.

Sovelluksenvaihtoalue – Tehtävärivillä on myös avoimina oleviin 
sovelluksiin liittyviä kuvakkeita. Tehtävärivillä näkyvät neljän ylimmän 
sovelluksen kuvakkeet. Muiden sovellusten kuvakkeet näkyvät erillisessä 
valikossa. 

Kun haluat palauttaa jonkin neljästä sovelluksesta, kosketa sovelluksen 
kuvaketta. Jos painat kuvaketta ohjauskynällä puolen sekunnin ajan, 
näkyviin tulee työkaluvihje. 

Kun haluat käyttää kaikkien avoimien sovellusten valikkoa, kosketa -
kuvaketta tai pidä aloitusnäppäintä painettuna. Kun haluat avata 
sovelluksen, kosketa sen nimeä. Kun haluat palata laitteen 
aloitusnäkymään, valitse Home.
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Sovelluksen otsikkoalue
Sovelluksen otsikkoalueella (2) näkyy käytössä olevan sovelluksen nimi 
ja avoinna olevan tiedoston nimi. Kun haluat avata sovellusvalikon, 
kosketa otsikkoa tai paina valikkonäppäintä.

Tilanilmaisinalue
Tilanilmaisinalueella (3) voi olla seuraavat kuvakkeet:

 ilmaisee, että laite on yhteydessä tietokoneeseen USB-kaapelilla.

 ilmaisee näytön kirkkauden nykyisen tason. Kuvakkeen avulla voit 
myös säätää näytön asetuksia.

 ilmaisee nykyisen äänenvoimakkuuden. Kuvakkeen avulla voit myös 
säätää äänenvoimakkuutta ja muita ääniasetuksia. Ääni on sitä 
voimakkaampi, mitä enemmän kuvakkeessa on palkkeja. Kun äänet on 
mykistetty, kuvake on .

Internet-yhteyden kuvakkeet näyttävät Internet-yhteyden tilan ja 
tyypin. Kuvakkeen avulla pääset myös yhteydenhallintaan ja voit avata 
sekä sulkea Internet-yhteyden.

 ilmaisee, että WLAN-yhteys on aktiivisena,  ilmaisee, että 
pakettidatayhteys (esimerkiksi GPRS) on aktiivisena,  ilmaisee, että 
datapuheluyhteys (esimerkiksi GSM) on aktiivisena,  ilmaisee, että 
Internet-yhteyttä ei ole, tai  ilmaisee, että laite on offline-tilassa, 
jossa yhteydet eivät ole sallittuja.

 ilmaisee, onko laite Bluetooth-yhteydessä puhelimen kanssa. Sen 
avulla voit myös vaihtaa puhelinta tai avata yhteydenhallinnan.

 ilmaisee, että laite on kytketty yhteensopivaan puhelimeen ja dataa 
siirretään näiden kahden laitteen välillä,  ilmaisee, että laitetta ei ole 
kytketty puhelimeen,  ilmaisee, että puhelinta ei ole valittu tai  
ilmaisee, että laite on offline-tilassa, jossa yhteydet eivät ole sallittuja.

 ilmaisee, kuinka paljon latausta akussa on jäljellä. Mitä enemmän 
kuvakkeessa on palkkeja, sitä enemmän latausta on jäljellä.
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Pienennys- ja sulkemispainikkeet
Pienennys- ja sulkemispainikkeilla (4) voi tehdä seuraavaa:

Jos kosketat -kuvaketta, nykyinen sovellus menee piiloon ja sen alla 
oleva sovellus tulee näkyviin. 

Jos kosketat -kuvaketta, nykyinen sovellus sulkeutuu.

Sovellusalue
Aloitusnäkymässä sovellusalueella (5) näkyvät Home-valikosta valitut 
toiminnot. Kun haluat lisätä toimintoja sovellusalueelle tai poistaa niitä 
siitä, kosketa Home-kuvaketta ja merkitse haluamasi toiminto tai poista 
sen merkintä. Jos avaat sovelluksen tehtäväriviltä, sovellus näkyy 
sovellusalueella.

Työkalurivi
Työkalurivillä (6) ovat käytössä olevan sovelluksen komentopainikkeet.

Kosketusnäytön kalibrointi
Jos laitteen kosketusnäyttö reagoi epätäsmällisesti, se täytyy ehkä 
kalibroida. Paina aloitusnäppäintä ja valikkonäppäintä, valitse Screen > 
Screen calibration sekä noudata näyttöön tulevia ohjeita.

■ Aloitusnäkymä
Kun kytket laitteeseen virran, aloitusnäkymä tulee näkyviin. 
Aloitusnäkymässä on monia toimintoja ja linkkejä. 

Kun haluat näyttää tai piilottaa toiminnon, kosketa Home-otsikkoa ja 
toiminnon nimeä.

Internet radio – Valitse Internet-radiokanava soittolistasta. Soittolistan 
sisältö on peräisin Suosikit-soittolistasta, jota voit muokata 
audiosoitinsovelluksessa. Lisätietoja on kohdassa "Internet-radio" 
sivulla  38.

Clock – Näyttää ajan digitaalisessa tai analogisessa muodossa. 
Päivämäärämuoto määräytyy maa-asetusten mukaan. Kun haluat 
asettaa kellonajan ja päivämäärän, kosketa kelloa kahdesti, jolloin 
sovellus avautuu.
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News – Jos olet tilannut uutispalvelun, laitteessa näkyvät 
lukemattomien uutisartikkelien määrä ja uusimpien uutisotsikoiden 
luettelo. Kun haluat katsella artikkelia, kosketa sen otsikkoa. Kun haluat 
päivittää artikkeliluettelon Webistä, kosketa -kuvaketta. Kun haluat 
lopettaa päivityksen, kosketa -kuvaketta. Lisätietoja on kohdassa 
"Uutistenlukuohjelma" sivulla  39.

Web shortcut – Aseta Web-sivu, joka avautuu linkkikuvaa 
koskettaessasi, valitsemalla Home > Web shortcut details. Kirjoita Web-
sivun osoite. Kun haluat valita kuvan, kosketa Browse-kuvaketta. Tämän 
ominaisuuden toiminta voi vaihdella riippuen ostamastasi 
tuotepaketista.

Kun haluat asettaa taustakuvan aloitusnäkymään, valitse Home > 
Screen > Set background image.... Valitse kuva oletustaustakuvien 
luettelosta tai kosketa Browse-kuvaketta.

Kun haluat mukauttaa laitteen ilmettä ja tyyliä, valitse Home > Screen 
> Personalization.

Kun haluat kalibroida kosketusnäytön, valitse Home > Screen > 
Screen calibration.

■ Laitteen hallinta
Voit hallita laitetta kahdella tavalla: koskettamalla näyttöä 
ohjauskynällä tai painamalla selausnäppäintä ja laitteen muita 
näppäimiä.

Ohjauskynä
Kun haluat avata sovelluksen, kosketa sen kuvaketta tehtävärivillä. 
Valitse haluamasi toiminto valikosta, joka näkyy kuvakkeen vieressä.

Kun haluat sulkea sovelluksen, kosketa -kuvaketta näytön oikeassa 
yläkulmassa.

• Koskettaminen kerran – Kun haluat ottaa käyttöön säätimiä ja muita 
käyttöliittymän vuorovaikutteisia osia, kosketa niitä kerran 
ohjauskynällä (paina ohjauskynä alas ja vapauta se saman kohteen 
päällä). Koskettaminen kerran saattaa avata valintaluettelon, ottaa 
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käyttöön valintaikkunan painikkeen tai Web-sivun linkin, valita 
valintaruudun ja ottaa käyttöön tekstinsyöttötavan tekstikentästä.

• Valitseminen ja käyttöönotto – Kun haluat valita kohteen, kosketa 
sitä kerran ohjauskynällä. Kun haluat ottaa kohteen käyttöön tai 
avata sen, kosketa sitä uudelleen. Tämän toiminnon avulla voit 
käyttää ja ottaa käyttöön tiedostoihin ja muihin kohteisiin 
kohdistuvia toimintoja (esimerkiksi asiakirjojen kopioiminen) 
luettelo- ja valikkonäkymissä.

• Jatkuva moninkertainen valinta – Kun haluat valita peräkkäisiä 
kohteita, aseta ohjauskynä valitsemattoman kohteen päälle ja vedä 
ohjauskynä kohteiden yli.

• Vetäminen ja pudottaminen – Kun haluat vetää kohdetta, pidä 
ohjauskynä alaspainettuna valitun kohteen päällä, vedä kohde 
uuteen paikkaan ja vapauta ohjauskynä. Kun haluat vetää ja 
pudottaa useita kohteita, valitse peräkkäiset kohteet ja aloita 
vetäminen valitusta kohteesta.

• Tilannekohtaiset valikot – Kun haluat ottaa käyttöön 
tilannekohtaisen valikon, pidä ohjauskynää kohteen päällä 
alaspainettuna sekunnin ajan.

Laitteen näppäimet
Näppäimen painallus tarkoittaa näppäimen painamista ja 
vapauttamista. Ensisijainen toiminto toteutuu näppäimen painamisen 
jälkeen ja ennen sen vapauttamista. Jotkin toiminnot määräytyvät 
näppäimen painalluksen pituuden mukaan.

• Virtanäppäin – Lyhyt näppäimen painallus avaa Device mode -
valintaikkunan. Pitkä näppäimen painallus kytkee laitteen päälle tai 
pois päältä.

• Suurennus- ja pienennysnäppäin – Lyhyt näppäimen painallus 
muuttaa nykyisen näkymän zoomaustasoa ja säätää 
äänenvoimakkuutta äänisovelluksissa.

• Kokonäyttönäppäin – Lyhyt näppäimen painallus ottaa vuorotellen 
käyttöön koko näyttö- tai normaalinäyttö-tilan.
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• Selausnäppäin – Lyhyt näppäimenpainallus siirtää valinnan 
kohteesta toiseen haluamaasi suuntaan. Pitkä näppäimenpainallus 
Web-selaimessa selaa aktiivisena olevan sivun tai kuvan sisältöä. 
Paina selausnäppäimen keskiosaa, kun haluat ottaa käyttöön 
kohteen, joka on valittuna, ja vastata myönteisesti vahvistaviin 
kysymyksiin.

• Escape-näppäin – Lyhyt näppäimenpainallus poistaa kohdistimen 
tekstikentistä, peruuttaa valikot ja valintaikkunat ja vastaa 
kieltävästi vahvistaviin kysymyksiin. Pitkä näppäimen painallus 
sulkee ylimmän valintaikkunan tai sovellusnäkymän. Web-
selaimessa tämä näppäin toimii peruutuspainikkeena.

• Valikkonäppäin – Lyhyt näppäimen painallus avaa ja sulkee 
sovellusvalikon.

• Aloitusnäppäin – Lyhyt näppäimen painallus avaa laitteen 
aloitusnäkymän. Pitkä näppäimen painallus ottaa käyttöön 
sovelluksenvaihtoalueen.

■ Tekstinsyöttötavat
Voit kirjoittaa kirjaimia, numeroita ja erikoismerkkejä kahdella tavalla. 
Virtuaalinäppäimistön avulla voit koskettaa merkkejä. 
Käsialantunnistus-toiminnon avulla voit kirjoittaa merkkejä 
ohjauskynällä suoraan näyttöön.

Kun haluat aloittaa tekstinsyötön, kosketa tekstikenttää tai paina 
selausnäppäimen keskiosaa tekstikentän ollessa kohdistettuna. 
Tekstinsyöttöalue on näytön alaosassa ja siinä näkyy 
virtuaalinäppäimistö tai käsialantunnistusalue aiemmin käytetyn 
tekstinsyöttötavan mukaan.

Kun haluat vaihtaa tekstinsyöttötavasta toiseen, kosketa -kuvaketta 
tekstinsyöttöalueella ja valitse Input method ja haluamasi vaihtoehto. 
Ala kirjoittaa tekstiä. 

Kun haluat määrittää tekstinsyöttöasetukset, kosketa -kuvaketta ja 
valitse Control panel > Text input settings.
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Laite voi täydentää sanoja valitun kielen perusteella. Laitteessa on 
kunkin tuetun tekstinsyöttökielen sanakirja. Laite myös oppii uusia 
sanoja käyttäjän kirjoittamasta tekstistä.

Kun haluat kytkeä ennakoivan tekstinsyötön päälle, valitse Word 
completion. Kun haluat kytkeä ennakoivan tekstinsyötön pois päältä, 
poista valinta. Kun ennakoiva tekstinsyöttö on päällä, laite ehdottaa 
sanoja, jotka vastaavat virtuaalinäppäimistöllä kirjoittamasi sanan 
ensimmäisiä kirjaimia.

Virtuaalinäppäimistö

• Sarkainnäppäin (1) – Lisää sarkainvälin tai siirtää kohdistimen 
seuraavaan käytettävissä olevaan tekstinsyöttökenttään.

• [ABC] (2) – Kirjoittaa näppäimistöllä isoja kirjaimia. 
Käsialantunnistuksessa vaihtaa normaalien merkkien ja 
erityismerkkien tunnistustilan välillä.

• Vaihtonäppäin (3) – Voit kirjoittaa ison kirjaimen 
virtuaalinäppäimistötilassa, kun olet kirjoittamassa pieniä kirjaimia. 
Kun painat tätä näppäintä käsialantunnistustilassa, viimeksi 
kirjoittamasi pieni kirjain vaihtuu isoksi kirjaimeksi ja päinvastoin.

• Tekstinsyöttövalikon näppäin (4) – Avaa tekstinsyöttövalikon. 

• Virtuaalinäppäimistö (5) – Syöttää tekstiä.

• Välilyöntinäppäin (6) – Lisää välilyönnin.

• Numeronäppäimistö (7)

• Askelpalautinnäppäin (8) – Poistaa merkin kohdistimen vasemmalta 
puolelta.

• Enter-näppäin (9) – Siirtää kohdistimen seuraavalle riville tai 
tekstinsyöttökenttään. Mahdollistaa tilannekohtaisia lisätoimintoja 
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(toimii esimerkiksi Web-selaimen Web-osoitekentässä 
siirtymispainikkeena).

• Erityismerkkinäppäin (10) – Avaa erityismerkkinäkymän, jossa voit 
valita yleisesti käytettäviä erityismerkkejä, symboleja ja 
kielikohtaisia merkkejä.

• Sulkemisnäppäin (11) – Sulkee virtuaalinäppäimistön ja 
käsialantunnistuksen syöttöalueen ja tallentaa muutokset. 

Käsialantunnistus
Voit kirjoittaa tekstiä käyttämällä ohjauskynää kynänä. Kirjoita helposti 
luettavia, pystysuoria merkkejä ja erota merkit toisistaan pienillä väleillä 
vaakasuunnassa. Älä käytä kursiivia. 

Kun haluat kirjoittaa tavallisia merkkejä ja numeroita (oletustila), 
kirjoita sanat normaaliin tapaan.

Kun haluat kirjoittaa erityismerkkejä, kosketa [Abc1]-kohtaa 
syöttöalueen vasemmanpuoleisessa ruudussa ja kirjoita merkit 
normaaliin tapaan.

Kun haluat piirtää vapailla liikkeillä, katso 
kuviota. Piirrä askelpalautin liikkeellä 1, 
välilyönti liikkeellä 2, rivinvaihto liikkeellä 
3 ja sarkainväli liikkeellä 4.

Kun haluat poistaa merkkejä, piirrä 
askelpalautusliike oikealta vasemmalle valitsemasi merkin päälle. 

Kun haluat lisätä uusia merkkejä sanojen sisään ja niiden jälkeen, piirrä 
ne haluamiisi kohtiin.

■ Äänenvoimakkuuden säätäminen
Kun haluat säätää äänenvoimakkuutta, kosketa -kuvaketta 
käyttääksesi ääniasetuksia. Kun haluat pienentää tai lisätä 
äänenvoimakkuutta, vedä äänenvoimakkuuden liukusäädin haluamaasi 
asentoon.

Varoitus: Kuuntele musiikkia kohtuullisella 
äänenvoimakkuudella. Jatkuva altistuminen suurelle 
äänenvoimakkuudelle voi vahingoittaa kuuloasi. 
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■ Laitteen suojaus
Kun haluat estää laitteen luvattoman käytön, muuta suojakoodi ja aseta 
laite lukittumaan automaattisesti tietyn aikakatkaisuajan jälkeen.

Kun haluat muokata suojausasetuksia, kosketa -kuvaketta  ja valitse 
Control panel > Device lock. Security-valintaikkuna avautuu.
Kun haluat ottaa laitteen automaattisen lukituksen käyttöön, valitse 
Use device lock, kirjoita suojakoodi ja kosketa OK-kuvaketta.

Kun haluat asettaa aikakatkaisuajan, kosketa Autolock period 
-luetteloa ja valitse haluamasi aika.

Suojakoodia muutetaan seuraavasti: 

1. Kosketa Change lock code -kuvaketta. Kirjoita nykyinen suojakoodi 
(oletuskoodi on 12345) ja kosketa OK-kuvaketta.

2. Kirjoita uusi koodi ja kosketa OK-kuvaketta.

3. Kirjoita uusi koodi uudelleen ja kosketa OK-kuvaketta. 

Suojauksen tehostamiseksi OK-kuvake on käytettävissä vasta lyhyen 
viiveen jälkeen kunkin vaiheen välillä.

Jos kosketat Cancel-kuvaketta jossain näistä valintaikkunoista, 
laitteen suojakoodi ei muutu.

Pidä uusi koodi salassa ja säilytä sitä turvallisessa paikassa erillään 
laitteesta.

Kun haluat lukita laitteen suojakoodilla, paina lyhyesti virtanäppäintä. 
Valitse Device mode -valintaikkunassa Lock device > OK. Jos et ole 
ottanut käyttöön Use device lock -suojausasetuksia ohjauspaneelissa, 
Enter lock code -valintaikkuna avautuu, ja laite on lukittava syöttämällä 
koodi. 

Kun haluat avata laitteen lukituksen, paina virtanäppäintä, kirjoita 
suojakoodi ja kosketa OK-kuvaketta.

Huomautus: Jos kadotat laitteen suojakoodin, vie laite 
valtuutettuun  Nokia-huoltoliikkeeseen. Lukituksen avaamiseksi 
ohjelmisto on ladattava laitteeseen uudelleen, minkä 
seurauksena kaikki laitteeseen tallentamasi tieto voi hävitä.
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Kosketusnäytön ja näppäimistön lukitus
Kun haluat lukita kosketusnäytön ja näppäimet, paina lyhyesti 
virtanäppäintä ja valitse Lock touch screen and keys > OK. 
Kun haluat avata kosketusnäytön ja näppäimien lukituksen, paina 
virtanäppäintä ja selausnäppäimen keskiosaa.

Kosketusnäyttö ja näppäimistö lukittuvat automaattisesti, kun 
suojakuori asetetaan laitteen näytön päälle. Kosketusnäytön ja 
näppäimistön lukitus avautuu, kun kuori poistetaan.

■ Muistinhallinta
Kun haluat tarkastella muistin tämänhetkistä kulutusta, kosketa 

-kuvaketta  ja valitse Control panel > Memory.

Kun haluat tarkastella vapaana olevan ja käytetyn muistin määrää sekä 
laitteessa tai muistikortilla olevien erilaisten tietojen muistin kulutusta, 
valitse Device tai Memory card -sivu.

Kun haluat vapauttaa muistia, poista tietoja tiedostonhallinnassa tai 
muissa sovelluksissa. Kun haluat etsiä ja poistaa tietynkokoisia 
tiedostoja, käytä Search-sovellusta. 

Sovellukset lähettävät virheilmoituksen yrittäessäsi siirtää, kopioida tai 
tallentaa tiedostoja, kun laitteen tai muistikortin muisti ei riitä.

■ Ohje
Nokia 770 Internet Tablet -kämmenselaimessa on ohjetoiminto, jonka 
avulla saat lisätietoja laitteen ominaisuuksista, sovelluksista ja 
valintaikkunoista.

Kun haluat käyttää ohjetta tehtäväriviltä, kosketa -kuvaketta ja 
valitse Help.

Kun haluat käyttää sovelluksen ohjetta, kosketa sovelluksen otsikkoa ja 
valitse ohjekomento valikosta (tavallisesti työkaluvalikosta).

Ohjeaiheita selataan seuraavasti:

• Kosketa - tai -kuvaketta, kun haluat nähdä muita ohjeaiheita, 
jos olet äskettäin katsellut useita ohjeaiheita.
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• Kosketa -kuvaketta, kun haluat nähdä luettelon äskettäin 
katselemistasi ohjeaiheista.

• Kosketa -kuvaketta, kun haluat etsiä hakukenttään kirjoittamaasi 
tekstiä.

Kun haluat käyttää valintaikkunaan liittyvää ohjetta (tilannekohtainen 
ohje), kosketa valintaikkunassa ?-painiketta.

■ Tietojen hakeminen
Luomiasi tai hakemiasi tiedostoja etsitään seuraavasti:

1. Kosketa -kuvaketta ja valitse Search.

2. Kirjoita hakusana tai useita hakusanoja. Mitä useampia hakusanoja 
käytät, sitä täsmällisempiä hakutulokset ovat.

3. Rajoita tarvittaessa etsintä sähköpostiviesteihin, yhteystietoihin tai 
kirjanmerkkeihin tai valitse kaikki laitteessa olevat tiedostot. Kun 
haluat asettaa lisää hakuvaihtoehtoja, kosketa Options-kuvaketta.

4. Kun haluat aloittaa etsinnän, kosketa OK-kuvaketta. Tulokset 
näkyvät Search Results -ikkunassa.

5. Kun haluat lopettaa etsinnän, kosketa -kuvaketta työkalurivillä.

Laitteen hakutoiminto käyttää Boolen logiikan JA-operaattoria. Mitä 
useampia hakusanoja ja vaihtoehtoja asetat, sitä tarkempia 
hakutulokset ovat. Jos saat liian vähän tuloksia, rajoita hakusanojen ja 
vaihtoehtojen määrää. Isojen ja pienten kirjainten välillä ei ole eroa 
hakutoiminnossa.

4. Internet-yhteyden muodostaminen

Internet-yhteyden käyttäminen edellyttää muodostettavan Internet-
yhteyden ja käytettävän Internet-palvelimen asetusten määrittämistä.

Kun haluat muodostaa Internet-yhteyden, kosketa -kuvaketta 
tehtävärivillä ja valitse kirjanmerkki. Select connection -valintaikkuna 
avautuu, laite etsii WLAN-verkkoja ja tuo esiin luettelon kaikista 
käytettävissä olevista yhteyksistä.  Valitse yhteys luettelosta ja kosketa 
Connect-kuvaketta.
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Kun haluat käyttää ja määrittää Internet-yhteyksiä manuaalisesti, 
kosketa -kuvaketta ja valitse Control panel > Connectivity settings > 
Connections.

Kun haluat luoda uuden yhteyden tai muokata aiempaa yhteyttä, 
kosketa New- tai Edit-kuvaketta. Jos kosketit New-kuvaketta, ohjatun 
Internet-asetusten määritystoiminnon tervetuloa-sivu tulee näkyviin. 
Kosketa Next-kuvaketta, kun haluat jatkaa ja siirtyä Connection setup: 
Name and type -valintaikkunaan. 

Kun haluat poistaa yhteyden, kosketa Delete-kuvaketta.

■ Uuden WLAN-yhteyden luominen 
WLAN-yhteys määritetään manuaalisesti seuraavasti:

1. Määritä Connection setup: Name and type -valintaikkunassa 
seuraavat asetukset:

Connection name – Anna yhteydelle kuvaava nimi.

Connection type – Valitse WLAN. 

Kosketa Next-kuvaketta. Laite kysyy, haluatko etsiä käytettävissä 
olevia WLAN-verkkoja. Kosketa Yes-kuvaketta, kun haluat aloittaa 
etsinnän. Kosketa No-kuvaketta, kun haluat ohittaa sen.

Etsinnän jälkeen esiin tulee luettelo kaikista käytettävissä olevista 
WLAN-verkoista ja tiedot jokaisesta WLAN-yhteydestä: 

• WLAN-yhteyden suojaustaso: 

 – Ei suojausta (esimerkiksi julkisen paikan WLAN-tukiasema 
lentokentällä)

 – Keskitasoinen suojaus (WEP- eli Wired Equivalent Privacy -
todennus) 

 – Hyvä suojaus (WPA- eli Wi-Fi Protected Access -todennus) 

Verkon suojaustaso vaikuttaa Next-kuvaketta koskettaessasi 
näkyviin tuleviin asetuksiin.

• WLAN-verkon nimi

• WLAN-kentän voimakkuus
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• , jos WLAN-verkko on jo määritetty laitteeseen tallennetussa 
Internet-yhteyden asetuksessa 

2. Tallenna asetukset koskettamalla Finish-kuvaketta. Kun haluat 
määrittää lisäasetuksia, kosketa Advanced-kuvaketta. Lisätietoja on 
Internet-asetusten ohjeessa.

Vihje: Voit joutua määrittämään lisäasetuksia, jos Internet-
yhteys edellyttää esimerkiksi välityspalvelinten käyttöä. 

■ Olemassa olevan WLAN-yhteyden 
muokkaaminen

Seuraavat asetukset näkyvät, kun muokkaat olemassa olevaa WLAN-
yhteyttä tai kun olet ohittanut WLAN-verkkojen etsinnän: 

Network name (SSID): – Tämä kenttä on tyhjä, tai siinä näkyy aiemmin 
määritetyn yhteyden nimi.

Network mode – Voit valita Infrastructure tai Ad hoc. Rakennetilaa 
(Infrastructure) käytetään Internet-yhteyksien kanssa.

Security method: – Valitse None (ei suojausta), WEP (keskitasoinen 
suojaus), WPA pre-shared key (hyvä suojaus) tai WPA with EAP (hyvä 
suojaus).

Vihje: Laite tukee WEP- eli Wired Equivalent Privacy 
-todennuksen 40 tai 104 bitin avaimien pituuksia (vastaa 64:ää 
tai 128:aa bittiä WLAN-tukiaseman merkin mukaan).

Valitse tukiasemassa esimerkiksi 40 (64) bittiä ja kirjoita viisi 
merkkiä. Valitse laitteessa vastaavasti 40 bittiä ja kirjoita samat 
viisi merkkiä.

■ Uuden yhteyden luominen
Ennen kuin matkapuhelinverkon avulla voidaan avata Internet-yhteys, 
yhteensopiva matkapuhelin on liitettävä pariksi laitteen kanssa. Laite 
tarvitsee ulkoisen modeemin (puhelin), joka liitetään laitteeseen 
langattomalla Bluetooth-tekniikalla. 
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Langaton Bluetooth-tekniikka
Kun haluat muodostaa Internet-yhteyden matkapuhelinverkon avulla, 
liitä yhteensopiva Nokia-puhelin Nokia 770 Internet Tablet -
kämmenselaimeen langattomalla Bluetooth-tekniikalla.

Tämä laite on Bluetooth-määrityksen 1.2 mukainen.  Määritys tukee 
seuraavia profiileja: puhelinverkkoyhteys (Dial-Up Networking), 
tiedostonsiirto (File Transfer) tai objektinvaihto (Object Exchange), 
yleinen käyttö, SIM-yhteys ja sarjaportti. 

Joissakin paikoissa voi olla Bluetooth-tekniikan käyttöä koskevia 
rajoituksia. Tarkista asia paikallisilta viranomaisilta tai 
palveluntarjoajalta.

Bluetooth-tekniikkaa käyttävät toiminnot tai sellaisten jättäminen 
päälle taustalle muita toimintoja käytettäessä lisää akkuvirran tarvetta 
ja lyhentävät akun käyttöikää. 

Bluetooth-yhteys ei edellytä, että yhteensopiva puhelin ja Nokia 770 
Internet Tablet -kämmenselain ovat näköetäisyydellä, mutta niiden on 
oltava enintään 10 metrin päässä toisistaan. Yhteyksiin voivat vaikuttaa 
laitteiden välissä olevat esteet, kuten seinät tai muut elektroniset 
laitteet.

Laite toimii aina tilassa, jossa laitetta ei voi havaita ja jossa siihen ei voi 
muodostaa yhteyttä. Laite ei myöskään näy muille laitteille Bluetooth-
yhteyden avulla, ellet luo sellaista yhteyttä. Älä muodosta yhteyksiä 
Bluetooth-laitteisiin, joihin et luota.

Puhelimen liittäminen pariksi laitteen kanssa
Puhelimen liittäminen pariksi laitteiden kanssa on aina aloitettava 
Nokia 770 Internet Tablet -kämmenselaimesta. Vaikka voit käyttää vain 
yhtä puhelinta kerrallaan, voit liittää useita puhelimia pariksi laitteen 
kanssa.

Puhelin liitetään pariksi laitteen kanssa seuraavasti:

1. Kosketa -kuvaketta tilanilmaisinalueella ja valitse Select phone.... 
Puhelimen valinnan ohjattu toiminto avautuu, ja laite alkaa etsiä 
yhteensopivia Bluetooth-laitteita. Jos olet jo liittänyt puhelimen 
pariksi laitteen kanssa, valikon kohta on nimeltään Change phone.... 
Valitse siinä tapauksessa Change phone... ja kosketa New-kuvaketta.
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2. Valitse haluamasi puhelin löytyneiden laitteiden luettelosta ja 
kosketa Next-kuvaketta. Laite muodostaa salasanan.

3. Käytä muodostettua salasanaa tai korvaa se omalla salasanallasi. 
Kosketa Next-kuvaketta ja anna sama salasana puhelimeen.

4. Tallenna asetukset koskettamalla Finish-kuvaketta.

Vihje: Aseta Nokia 770 Internet-kämmenselain luotetuksi 
laitteeksi puhelimen Bluetooth-valikosta. Näin voit antaa laitteen 
käyttää puhelinta, eikä käyttöön otettavaa yhteyttä tarvitse 
vahvistaa joka kerralla. Lisätietoja on puhelimen käyttöoppaassa.

Pariksi liitettyä puhelinta muutetaan seuraavasti:

1. Kosketa -kuvaketta tilanilmaisinalueella ja valitse Change 
phone.... Phone-valintaikkuna avautuu, ja kaikki pariksi liitetyt 
puhelimet näkyvät Selected phone: -luettelossa. 

2. Valitse haluamasi puhelin ja kosketa OK-kuvaketta.

Kun haluat katsella valitsemasi puhelimen yksityiskohtaisia tietoja, 
kosketa Details-kuvaketta. 

Kun haluat poistaa valitun puhelimen luettelosta, valitse Details > 
Delete.

Yhteyden asentaminen
Ennen kuin voit muodostaa Internet-yhteyden matkapuhelinverkon 
avulla, tee seuraavat toimenpiteet:

• Tilaa tarvittava datapalvelu palveluntarjoajalta.

• Hanki tarvittavat Internet-asetukset palveluntarjoajalta.

Vihje: Laitteessa on asetustietokanta, jossa on joidenkin 
matkapuhelinoperaattoreiden ennalta määritettyjä asetuksia. 
Valitse operaattori luettelosta, jolloin asetukset asentuvat 
laitteeseen. Kun haluat käyttää tietokantaa, kosketa 

-kuvaketta ja valitseControl panel > Control panel > Tools > 
Setup wizard....

Huomautus: Kaikkien matkapuhelinoperaattoreiden asetukset 
eivät näy luettelossa, ja jotkin asetukset saattavat olla 
vanhentuneita.
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Yhteys asennetaan manuaalisesti seuraavasti:

1. Määritä Connection setup: Name and type -valintaikkunassa 
seuraavat asetukset:

Connection name – Anna yhteydelle kuvaava nimi.

Connection type – Määritä, minkä tyyppisen verkkopalvelun avulla 
haluat muodostaa Internet-yhteyden. Kun haluat käyttää 
matkapuhelinverkossa pakettidatapalvelua, jollainen esimerkiksi 
GPRS (verkkopalvelu) on, valitse Packet data. Kun haluat käyttää 
matkapuhelinverkossa piirikytkentäistä datapalvelua, jollainen 
esimerkiksi nopea piirikytkentäinen HSCSD (High-Speed Circuit-
Switched Data) -datapalvelu on, valitse Data call. 

2. Valitse Select cellular network type -valintaikkunassa, 
minkätyyppisen matkapuhelinverkon avulla Internet-yhteys 
muodostetaan: GSM/UMTS tai CDMA. Sinun on valittava verkon 
tyyppi itse, jos et ole liittänyt matkapuhelinta pariksi laitteen kanssa.

3. Määritä Yhteyden asennus -valintaikkunassa seuraavat asetukset:

Vihje: GPRS-pakettidataverkoissa yhteysosoite on yleisesti 
Internet tai se jätetään määrittämättä. Valintanumero on 
tavallisesti *99# ja käyttäjänimi sekä salasana saatetaan 
jättää määrittämättä. Pyydä CDMA-pakettidataverkon 
asetukset palveluntarjoajalta.

Access point name – Anna Internet-yhteysosoitteen nimi. Pyydä nimi 
Internet-palveluntarjoajalta. Tämä asetus näkyy, jos valitsit 
pakettidatayhteyden puhelimen käyttäessä GSM-
matkapuhelinverkkoa.

Dial-up number – Anna Internet-yhteysosoitteen 
modeemipuhelinnumero.

User name – Kirjoita tarvittaessa käyttäjänimi. Saat käyttäjänimen 
tavallisesti Internet-palveluntarjoajalta.

Password – Kirjoita tarvittaessa salasana. Saat salasanan tavallisesti 
Internet-palveluntarjoajalta.
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Prompt password at every login: – Valitse tämä vaihtoehto, jos haluat 
kirjoittaa uuden salasanan aina kirjautuessasi Internet
-palvelimelle tai jos et halua tallentaa salasanaasi laitteeseen.

4. Kun olet valmis, määritä tarvittaessa lisäasetukset koskettamalla 
Advanced-kuvaketta Connection setup: Complete 
-valintaikkunassa. Lisätietoja on sovelluksen ohjeessa.

■ Yhteysasetukset
Kun käytät sovellusta, joka edellyttää Internet-yhteyden 
muodostamista, laite pyytää valitsemaan käytettävän yhteyden 
(Internet-yhteysosoite).

Valitse yhteys luettelosta Select connection -valintaikkunassa ja 
kosketa Connect-kuvaketta. Vain käytettävissä olevat yhteydet näkyvät 
valintaikkunassa. Yhteys, jonka asetat ensisijaiseksi, näkyy luettelon 
yläosassa. Jos et ole asettanut ensisijaista yhteyttä, viimeksi käytetty 
yhteys (jos käytettävissä) näkyy ensimmäisenä. 

Kun haluat määrittää yhteysasetukset, kosketa -kuvaketta ja valitse 
Control panel > Connectivity settings.

Määritä General-sivulla seuraavat asetukset:

Preferred connection – Kun haluat muuttaa ensisijaista yhteyttä, valitse 
yhteys luettelosta.

Use without asking – Jos valitset tämän vaihtoehdon, Preferred 
connection 
-kohdassa valitsemaasi Internet-yhteysosoitetta käytetään 
automaattisesti käynnistäessäsi Internet-yhteyttä edellyttävän 
sovelluksen. Tässä tapauksessa yhteyttä ei tarvitse vahvistaa.

Valitse Idle times -sivulla aika, jonka jälkeen Internet-yhteys katkeaa 
automaattisesti, jos yhteyttä ei käytetä. Käytä Packet data idle time -
asetusta pakettikytkentäisissä datayhteyksissä (esimerkiksi GPRS), Data 
call idle time -asetusta piirikytkentäisissä datapuheluissa (esimerkiksi 
GSM-data) ja WLAN idle time -asetusta langattoman lähiverkon 
(WLAN) yhteysosoitteen avulla muodostettavissa yhteyksissä.
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Huomautus: Internet-yhteyksissä saatetaan käyttää 
aikaperusteisia maksuja. Tarkista asia palveluntarjoajalta ja 
säädä odotusajat vastaavasti.

Huomautus: Verkossa saatetaan käyttää myös odotusaikoja, 
jotka voivat aiheuttaa Internet-yhteyden katkeamisen laitteen 
odotusajoista riippumatta.

Kun haluat käyttää yhteyttä automaattisesti, valitse Control panel > 
Connectivity settings> General. Määritä, että haluamasi yhteys on 
Preferred connection, ja valitse Use without asking.

Yhteyksien ottaminen pois käytöstä
Kun haluat ottaa WLAN- ja Bluetooth-yhteydet pois käytöstä, paina 
lyhyesti virtanäppäintä ja valitse Offline mode ja kosketa OK-kuvaketta. 
Kun haluat ottaa yhteydet käyttöön, paina lyhyesti virtanäppäintä, 
valitse Normal mode ja kosketa OK-kuvaketta.

WLAN- ja Bluetooth-yhteydet poistuvat käytöstä myös silloin, kun 
laitteen päälle asetetaan suojakuori.

Huomautus: Offline-tilassa ei voi käyttää ominaisuuksia, jotka 
edellyttävät verkko- tai Bluetooth-yhteyttä. Kun haluat käyttää 
ominaisuuksia, sinun on ensin palautettava laite normaalitilaan. 
Jos laite on lukittu, anna suojakoodi.

5. Web-selain 

Kun haluat avata selaimen, kosketa -kuvaketta ja valitse Open new 
browser window tai kirjanmerkki.

Ennen kuin voit muodostaa Internet-yhteyden, määritä Internet-
yhteyden asetukset. Tarkat ohjeet ovat kohdassa 
"Internet-yhteyden muodostaminen" sivulla  24.

Tärkeää: Käytä vain luotettavia palveluja, joissa on riittävä 
suojaus vahingollisia ohjelmia vastaan.
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■ Web-selailu
Kun haluat avata Web-sivun, kosketa näytön alaosassa olevaa 
osoitekenttää ja kirjoita osoite virtuaalinäppäimistöllä. Voit myös liittää 
osoitteen, jonka olet leikannut tai kopioinut muusta sovelluksesta. 
Kosketa kuvaketta -kuvaketta. 

Jos olet tallentanut kirjanmerkin Web-sivusta, jonka haluat avata, 
kosketa -kuvaketta ja valitse haluamasi kirjanmerkki.

Kun haluat selata ja vierittää Web-sivua, vedä sivua haluamaasi 
suuntaan ohjauskynällä, käytä selausnäppäimiä tai vedä näytön oikealla 
puolella ja alaosassa olevia vierityspalkkeja.

Kun haluat suurentaa tai pienentää sivun kokoa, kosketa suurennus- ja 
pienennysnäppäintä. Kun haluat valita ennalta määritetyn 
zoomaustason sovellusvalikosta, valitse Web > View > Zoom ja 
haluamasi zoomaustaso.

Kun haluat nähdä Web-sivun koko näytön kokoisena, paina 
kokonäyttönäppäintä. Kun haluat palata normaalinäkymään, paina 
uudelleen kokonäyttönäppäintä.

Kun haluat nähdä Web-sivun optimoidun kokoisena, valitse View > 
Optimised view. Web-sivu sovittuu näytön levyiseksi. Teksti ja kuvat 
suurentuvat tai pienentyvät, ja niiden mittakaava muuttuu tarvittaessa 
eri tavalla.

Kun haluat päivittää nykyisen sivun, kosketa -kuvaketta. Kun haluat 
lopettaa päivittämisen, kosketa -kuvaketta 

Kun haluat selata äskettäin avaamiasi sivuja, kosketa kuvaketta  tai 
.

Huomautus: Välimuisti on muistipaikka, johon tietoja 
tallennetaan tilapäisesti. Jos olet käyttänyt tai yrittänyt käyttää 
salasanoja vaativia luottamuksellisia tietoja, tyhjennä välimuisti 
jokaisen käyttökerran jälkeen. Käyttämäsi tiedot tai palvelu 
tallentuvat välimuistiin. Kun haluat tyhjentää välimuistin, 
valitse Web > Tools > Clear cache. Välimuisti tyhjentyy 
automaattisesti myös, kun suljet Web-selaimen.
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Kun haluat muuttaa Web-selaimen asetuksia, valitse Web > Tools > 
Settings.... Lisätietoja on sovelluksen ohjeessa.

■ Kirjanmerkkien hallinta
Kun haluat hallita laitteeseen tallentamiasi kirjanmerkkejä, kosketa 

-kuvaketta ja valitse Bookmarks. Kirjanmerkkikansiot näkyvät 
vasemmalla, ja valitsemasi kansion sisältämät kirjanmerkit oikealla.

Huomautus: Laitteeseen voi olla ladattu valmiiksi sellaisten 
sivustojen kirjanmerkkejä, jotka eivät liity Nokiaan. Nokia ei 
takaa näiden sivustojen luotettavuutta tai vastaa niistä eikä tue 
niiden käyttöä. Jos kuitenkin päätät avata tällaisia sivustoja, 
noudata samoja turvallisuutta ja sisältöä koskevia varotoimia 
kuin muidenkin Internet-sivustojen kanssa.

Et ehkä voi muokata tai hallita ladattujen kirjanmerkkien 
sisältöä

Kun haluat avata kansion ja siinä olevan kirjanmerkin, kosketa kansiota 
ja kosketa kirjanmerkkiä kahdesti.

Kun haluat lisätä kirjanmerkin nykyiselle Web-sivulle, valitse 
Bookmark... >Web page > Add bookmark....

Kun haluat tallentaa linkin kirjanmerkkinä, pidä ohjauskynää 
alaspainettuna linkin päällä sekunnin ajan ja valitse Add link to 
Bookmarks....

6. Sähköposti

Kun haluat avata Sähköposti-sovelluksen, kosketa -kuvaketta ja 
valitse haluamasi toiminto valikosta. 

Tärkeää: Ole varovainen avatessasi viestejä. 
Sähköpostiviesteissä voi olla vahingollisia ohjelmia, tai ne 
voivat olla muulla tavoin haitallisia laitteelle.
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■ Sähköpostin perusasetukset
Sähköpostiviestien lähettäminen ja vastaanottaminen edellyttävät 
käytettävien sähköpostipalveluiden asetusten määrittämistä. Varmista 
oikeat asetukset ottamalla yhteys sähköpostipalvelun tarjoajaan.

Uusi postilaatikko luodaan seuraavasti:

1. Kosketa -kuvaketta ja valitse Go to Inbox. Ohjattu postilaatikon 
määritystoiminto avautuu. 

Jos olet jo tallentanut etäpostilaatikon asetukset, luo uusi 
postilaatikko valitsemalla E-mail > Tools > New mailbox....

2. Määritä seuraavat asetukset:

Mailbox name – Kirjoita postilaatikkoa kuvaava nimi.

Mailbox type – Valitse sähköpostipalvelun tarjoajan suosittelema 
sähköpostin yhteyskäytäntö. Tämän asetuksen voi valita vain kerran, 
eikä sitä voi muuttaa, kun olet tallentanut postilaatikon asetukset tai 
poistunut ohjatusta postilaatikon määritystoiminnosta. Kosketa 
Next-kuvaketta.

Name – Kirjoita nimesi. Nimi näkyy lähettämiesi viestien 
lähettäjäkentässä.

User name – Kirjoita palveluntarjoajalta saamasi käyttäjänimi. 
Käyttäjänimeä tarvitaan kirjauduttaessa postilaatikkoon.

Password – Kirjoita salasanasi. Salasanaa tarvitaan kirjauduttaessa 
postilaatikkoon. Jos jätät tämän kentän tyhjäksi, ohjelma pyytää 
antamaan salasanan, kun yrität muodostaa yhteyden 
sähköpostipalvelimella olevaan postilaatikkoon.

E-mail address – Kirjoita palveluntarjoajalta saamasi 
sähköpostiosoite. Osoitteessa on oltava @-merkki. Viesteihisi tulleet 
vastaukset lähetetään tähän osoitteeseen. Kosketa Next-kuvaketta.

Incoming server  – Kirjoita sähköpostin vastaanottamiseen 
käytettävän POP3- tai IMAP4-palvelimen nimi tai IP-osoite.

Outgoing server (SMTP) – Kirjoita sähköpostin lähettämiseen 
käytettävän palvelimen nimi tai IP-osoite. Kosketa Next-kuvaketta.
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SMTP (Simple Mail Transfer Protocol) -palvelimia käytetään 
sähköpostia lähetettäessä. Sähköpostin lähettämistä varten on 
määritettävä SMTP-palvelimen nimi tai IP-osoite, jotka 
sähköpostipalvelun tarjoaja luovuttaa käyttöösi.

Vihje: SMTP-palvelimen nimi tai IP-osoite saattavat olla 
erilaisia kuin palvelimen nimi tai vastaanottavan palvelimen 
IP-osoite (POP3 tai IMAP4). Jos käytät Internet-
palveluntarjoajan sähköpostia esimerkiksi 
matkapuhelinverkon avulla, saatat joutua käyttämään 
matkapuhelinverkon SMTP-palvelinta. Näin saatat joutua 
määrittämään Internet-tilaajaverkkojen määrän verran 
postilaatikoita, joista jokaisella on erilainen SMTP-palvelimen 
nimi tai IP-osoite.

3. Kosketa Finish-kuvaketta, kun haluat päättää postilaatikon 
asetusten määrittämisen, tai kosketa Advanced-kuvaketta, kun 
haluat määrittää valinnaisia sähköpostin asetuksia. Lisätietoja 
sähköpostin lisäasetuksista on sovelluksen ohjeessa.

■ Sähköpostin hakeminen ja lukeminen
Sinulle lähetettyä sähköpostia ei vastaanoteta automaattisesti 
laitteeseen vaan sähköpostipalvelimella olevaan etäpostilaatikkoosi. 
Kun haluat lukea sähköpostiviestejä, sinun on ensin muodostettava 
yhteys postilaatikkoon ja haettava sähköpostiviestit laitteeseen.

Kun haluat hakea sähköpostin etäpostilaatikosta, valitse E-mail > 
E-mail > Send and receive. Valitse, haetko sähköpostin kaikista 
postilaatikoista vai valitsemastasi postilaatikosta. Jos sinulla on 
sähköpostiviestejä Lähtevät-kansiossa, ne lähetetään samanaikaisesti.

Kun haluat avata viestin, kosketa kaksi kertaa sen viestin otsikkoa, jonka 
haluat lukea.

■ Sähköpostin luominen ja lähettäminen
1. Kosketa sähköpostikuvaketta tehtävärivillä. 

2. Kosketa -kuvaketta luodaksesi uuden viestin.
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3. Kirjoita vastaanottajan sähköpostiosoite. Erota vastaanottajat 
toisistaan puolipisteellä (;). Jos vastaanottaja on yhteystietojen 
luettelossa, kosketa -kuvaketta. Valitse vastaanottaja luettelosta 
ja kosketa Add-kuvaketta. Kosketa OK-kuvaketta, kun olet valinnut 
kaikki vastaanottajat. 

4. Täydennä aihe ja kirjoita viesti. Kun haluat lähettää viestin, kosketa 
-kuvaketta.

■ Sähköpostin ajastaminen
Voit lähettää ja vastaanottaa sähköpostiviestejä ajoitetuin väliajoin, 
kun Internet-yhteys on aktiivisena. Sähköpostin ajastusasetukset 
määritetään seuraavasti:

1. Valitse E-mail > E-mail > Scheduling....
2. Valitse postilaatikko, jossa haluat ottaa käyttöön ajastamisen, ja 

kosketa Edit-kuvaketta.

3. Kun haluat määrittää aloitus- ja lopetusajan sekä lähetys- ja 
vastaanottovälin, kosketa haluamaasi kenttää ja muuta aikaa 
koskettamalla nuolia. Jos käytät 12 tunnin kelloa, kosketa am/pm-
kenttää. Korosta Days:-kentässä viikonpäivät, joina haluat yhteyden 
muodostettavan.

4. Tallenna asetukset koskettamalla OK-kuvaketta.

■ Saapuneet-kansio
Vastaanotetut viestit ovat Inbox-kansiossa. Lukemattomien viestien 
otsikot näkyvät lihavoituina.

Kun haluat lähettää uuden viestin, kosketa -kuvaketta. Kun haluat 
vastata viestiin, kosketa -kuvaketta. Kun haluat lähettää vastauksen 
viestin lähettäjälle ja Kopio:-kenttään merkityille vastaanottajille, 
kosketa -kuvaketta. Kun haluat lähettää viestin edelleen, kosketa 

-kuvaketta. Kun haluat poistaa viestin, kosketa -kuvaketta. Kun 
haluat lähettää kaikki lähettämättömät viestit ja vastaanottaa kaikki 
uudet viestit, kosketa -kuvaketta 
Kun haluat etsiä viestiä, valitse E-mail > Tools > Search.
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■ Lähtevät-kansio
Lähettämistä odottavat viestit tallennetaan tilapäisesti Outbox-
kansioon. Kunkin viestin tila näkyy viestin otsikon vieressä:

Waiting – Viesti lähetetään, kun muodostat seuraavan kerran yhteyden 
postilaatikkoon.

On request – Viesti lähetetään vain, jos kosketat sitä ja -kuvaketta.

Suspended – Viestin lähettäminen on peruutettu Cancel sending -
toiminnolla.

Failed – Viestin lähetys ei onnistunut.

Kun haluat lähettää valitsemasi viestin uudelleen, kosketa 
-kuvaketta. Kun haluat peruuttaa valitsemasi viestin lähettämisen, 

kosketa -kuvaketta.

■ Lähetetyt-kansio
Kun viesti on lähetetty, se siirtyy Sent:-kansioon. 

Kun haluat määrittää Sent:-kansion asetukset, valitse E-mail > Folders 
> Folder settings.... Määritä seuraavat vaihtoehdot:

Sent folder clean-up on: – Valitse tämä, jos haluat sallia lähetettyjen 
viestien automaattisen poiston.

Remove messages older than: – Valitse, miten usein lähetetyt viestit 
poistetaan.

Select time: – Valitse, miten poistoväli mitataan: päivinä, viikkoina tai 
kuukausina.

■ Luonnokset-kansio
Drafts-kansioon voit tallentaa keskeneräiset viestit tai muut viestit, 
jotka haluat lähettää myöhemmin.

■ Omat kansiot
Kun haluat luoda uuden kansion, valitse E-mail > Tools > Manage 
folders.... Kosketa New-kuvaketta ja kirjoita uuden kansion nimi.
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Kun haluat poistaa kansion, kosketa kansiota ja valitse E-mail > Folders 
> Delete.

7. Mediasoittimet ja katseluohjelmat

■ Audiosoitin
Voit kuunnella laitteeseen, yhteensopivaan matkapuhelimeen tai 
muistikortille tallennettuja musiikki- ja muita äänitiedostoja sekä 
kuunnella suoratoistoäänitteitä Internetistä. Voit myös luoda ja hallita 
toistolistoja. Kosketa -kuvaketta ja valitse Audio player.

Audiosoitin tukee seuraavia tiedostomuotoja: AAC, AMR, MP2, MP3 ja 
WAV. Soitin ei välttämättä tue jonkin tiedostomuodon kaikkia 
muunnelmia. 

■ Internet-radio
Internet-radiosta voit kuunnella Internet-radiokanavia tai muita 
yhteensopivia suoratoistoja.

Radiokanava lisätään soittolistaan seuraavasti:

1. Kopioi haluamasi radiokanavan suoratoisto laitteen leikepöydälle 
Web-selaimessa. Pidä ohjauskynää alaspainettuna linkin päällä 
sekunnin ajan ja valitse Copy link location.

2. Kosketa laitteen aloitusnäkymässä -kuvaketta Internet radio 
channels: -valintakkunasta. Audiosoitinsovellus avautuu.

3. Valitse Audio player > Play list > Add stream.... 

4. Kosketa Web-osoitekenttää ja liitä radiokanavan suoratoiston linkki . 
Kosketa OK-kuvaketta. 

5. Valitse Audio player > Play list > Save. 

Kun haluat kuunnella radiokanavaa, valitse haluamasi kanava Internet 
radio channels: -valintaikkunan soittolistasta ja kosketa -kuvaketta. 

Kun haluat lopettaa kuuntelemisen, kosketa -kuvaketta. 
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Kun haluat säätää äänenvoimakkuutta, kosketa -kuvaketta ja vedä 
liukusäädintä ohjauskynällä. Kun haluat sulkea äänenvoimakkuuden 
ponnahdusikkunan, kosketa aluetta sen ulkopuolella. 

■ Videosoitin
Voit katsoa laitteeseen, yhteensopivaan matkapuhelimeen tai 
muistikortille tallennettuja videoleikkeitä. Voit myös katsoa videoita 
suoratoistona Internetistä. Kosketa -kuvaketta ja valitse Video 
player. 

Videosoitin tukee seuraavia tiedostomuotoja: AVI, H.263, MPEG-1, 
MPEG-4, RV (RealVideo) ja 3GP. Videosoitin ei välttämättä tue jonkin 
tiedostomuodon kaikkia muunnelmia.

■ Kuvat
Voit katsoa laitteeseen, yhteensopivaan matkapuhelimeen tai 
muistikortille tallennettuja kuvia. Kosketa -kuvaketta ja valitse 
Images.

Kuvankatseluohjelma tukee seuraavia tiedostomuotoja: BMP, GIF, ICO, 
JPEG, PNG, TIFF ja SVG Tiny. Kuvankatseluohjelma ei välttämättä tue 
jonkin tiedostomuodon kaikkia muunnelmia.

■ Uutistenlukuohjelma
Voit vastaanottaa ja lukea palveluntarjoajien RSS-uutissyötteitä. 
Palveluntarjoaja voi olla uutistoimisto, viihdesivusto tai online-
päiväkirjan tai -lehden kirjoittaja.

Kosketa -kuvaketta ja valitse News reader. Luomasi uutiskansiot 
näkyvät vasemmalla puolella. Niiden joukossa saattaa olla myös ennalta 
määritettyjä kansioita.

Kun haluat tilata uutissyötteen, kosketa -kuvaketta sovelluksen 
työkalurivillä ja kirjoita tai liitä uutissyötteen osoite Add feed 
-valintaikkunaan. Hanki osoite syötteentarjoajan Web-sivustosta. Etsi 
linkkiä, jonka otsikossa on XML tai RSS, ja kopioi linkin osoite 
tilannekohtaisen valikon avulla. Pidä ohjauskynää alaspainettuna linkin 
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päällä sekunnin ajan ja valitse Copy link location. Liitä linkki Add feed -
valintaikkunaan.

Uutistenlukuohjelma tukee seuraavia tiedostomuotoja: Rich Site 
Summary, RDF Site Summary, Really Simple Syndication (kaikki 
tunnetaan myös nimellä RSS) ja Atom.

■ PDF-lukuohjelma
Voit tarkastella dokumentteja PDF (portable document format) 
-muodossa. Kosketa -kuvaketta ja valitse PDF reader.

Lisätietoja mediasoittimien ja katseluohjelmien käyttämisestä on 
kunkin sovelluksen ohjeessa.

8. Ohjauspaneeli

Control panel -sovelluksen avulla voit suorittaa asetus- ja 
räätälöintitehtäviä. Kosketa -kuvaketta ja valitse Control panel. 
Luettelo käytettävissä olevista toiminnosta ja asetuksista tulee näkyviin. 
Lisätietoja on kunkin toiminnon ja asetuksen ohjeessa.

Application installer – Tämä ominaisuus on tarkoitettu vain ohjelmiston 
kehittäjille. Sen avulla voi asentaa uusia sovelluksia, tarkastella 
asennettuja paketteja ja poistaa valittuina olevia paketteja.

Backup/Restore – Voit kopioida tietoja muistikortille ja palauttaa sen 
laitteeseen.

Certificate manager – Voit tarkastella ja hallita digitaalisia varmenteita 
laitteessa.

Connectivity settings – Voit määrittää ensisijaisen langattoman 
yhteyden ja asettaa kaikkien yhteystyyppien odotusajat. Voit luoda ja 
muokata Internet-yhteysosoitteita.

Date & time – Voit valita kotikaupungin, päivämäärän, ajan ja 
kesäaikavyöhykkeen.

Device – Voit muuttaa laitteen nimen ja tarkastella laitetta sekä 
loppukäyttäjälisenssejä koskevia tietoja.
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Display – Voit muuttaa näytön kirkkautta ja asettaa kosketusnäytön 
sekä näppäimistön automaattisen lukituksen päälle ja määrittää, miten 
pian näyttö himmenee virran säästämiseksi ja miten pian näyttö 
kytkeytyy pois päältä.

Language and regional settings – Voit valita oman alueesi ja laitteesi 
kielen.

Memory – Voit tarkastella laitteen muistin ja asennetun muistikortin 
tilaa.

Personalization – Voit mukauttaa laitteen ilmettä ja tyyliä.

Screen calibration – Voit kalibroida kosketusnäytön.

Device lock – Voit ottaa käyttöön laitteen automaattisen suojauksen, 
asettaa aikakatkaisuajan ja vaihtaa laitteen suojakoodia.

Sounds – Voit säätää äänenvoimakkuuden tai mykistää kaikki laitteen 
äänet. Voit valita myös järjestelmän merkkiäänien, näppäimistön ja 
kosketusnäytön äänenvoimakkuuden tason.

Text input settings – Voit opettaa laitteelle käsialasi ja asettaa 
oletusarvon mukaiset sekä vaihtoehtoiset tekstinsyöttökielet. Voit myös 
asettaa merkintunnistuksen nopeuden ja kytkeä ennakoivan 
tekstinsyötön päälle tai pois päältä.

Kun haluat avata toiminnon tai asetuksen, kosketa sitä kerran 
ohjauskynällä.

Kun haluat valita ohjauspaneelinäkymän, valitse Control panel > View > 
Large icons näyttääksesi sovelluskuvakkeet valikkonäkymänä tai valitse 
Small icons näyttääksesi kuvakkeet luettelona.

Kun haluat palauttaa alkuperäiset tehdasasetukset, valitse Control 
panel > Tools > Restore original settings.... Tämä toiminto ei vaikuta 
luomaasi sisältöön, turvakoodeihin, salasanoihin, laitteen kieleen tai 
pelipisteisiin.

Kun haluat asentaa yhteysasetukset matkapuhelinoperaattorin 
tietokannasta, valitse Control panel > Tools > Setup wizard....
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9. Työkalut, apuohjelmat ja pelit

■ Tiedostonhallinta
 File manager -sovelluksessa voit siirtää, kopioida, nimetä uudelleen ja 
avata tiedostoja ja kansioita, jotka ovat käytettävissä laitteessa, 
yhteensopivassa matkapuhelimessa tai niihin asennetuilla 
muistikorteilla.
Kosketa -kuvaketta  ja valitse File manager. Pääkansiot näkyvät 
vasemmalla ja niihin sisältyvät alikansiot ja tiedostot oikealla.

■ Yhteydenhallinta
Connection manager -toiminnolla voit tarkastella ja hallita laitteella 
muodostettuja yhteyksiä. Kosketa -kuvaketta ja valitse Connection 
manager.

■ Laskin
Huomautus: Tämän laskimen tarkkuus on rajallinen, ja se on 
suunniteltu yksinkertaisiin laskutoimituksiin.

Kun haluat käyttää laskinta, kosketa -kuvaketta ja valitse Utilities > 
Calculator.

■ Kello
Voit asettaa päivämäärän ja ajan, valita analogisen tai digitaalisen 
kellon sekä siirtyä kieli- ja maa-asetuksiin. Kosketa -kuvaketta ja 
valitse Utilities > Clock tai kosketa näytön oikealla puolella näkyvää 
päivämäärää ja kellonaikaa. 

■ Huomautukset
Voit luoda ja tallentaa tekstihuomautuksia ja lähettää niitä 
sähköpostitse. Kosketa -kuvaketta ja valitse Utilities > Notes.

Huomautussovellus tukee seuraavia tiedostomuotoja: ascii (vain teksti 
ilman muotoilua) ja .note.html (muotoiltu teksti). Sovellus ei tue 
täydellistä .html-tiedostomuotoa.
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■ Piirrosohjelma
Voit piirtää yksinkertaisia kuvia ja lähettää niitä sähköpostitse. Kaikki 
luonnokset tallennetaan .png-tiedostomuodossa. Kosketa 

-kuvaketta ja valitse Utilities > Sketch.

■ Pelit
Laitteessa on kolme peliä: Chess, Mahjong ja Marbles.

Kun haluat aloittaa pelin, kosketa -kuvaketta ja valitse Games ja 
haluamasi peli. Kosketa Play-kuvaketta pelin aloitusnäytössä.

Lisätietoja laitteen työkalujen, apuohjelmien ja pelien käyttämisestä on 
kunkin sovelluksen ohjeessa.

10.  Muistikortit ja tietokoneeseen 
liittäminen

■ Muistikortit
Tämä laite tukee kahta jännitettä (1,8/3 V) ja yhtä jännitettä (3 V) 
käyttäviä pienikokoisia (RS-MMC) multimediakortteja. Tarkista 
pienikokoisen multimediakortin yhteensopivuus sen valmistajalta tai 
toimittajalta.

Voit käyttää muistikorttia lisätallennustilana. Voit varmuuskopioida 
tiedot muistikortille ja palauttaa ne tarvittaessa. Muista tehdä 
varmuuskopiot tai pitää kirjaa kaikista tärkeistä tiedoista.

Kun haluat asentaa muistikortin, katso kohtaa "Muistikortin 
asentaminen" sivulla  9.

Kun haluat tarkastella ja hallita muistikortin sisältöä, kosketa -
kuvaketta ja valitse File manager. 
Kun haluat nimetä muistikortin uudelleen, valitse File manager > 
Memory card > Rename....
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Kun haluat alustaa muistikortin, valitse File manager > Memory card > 
Format.... Kaikki tiedot poistuvat pysyvästi muistikortilta. Kosketa 
Format-kuvaketta.

Kun haluat varmuuskopioida tietoja, valitse File manager > Tools > Back 
up/Restore... ja kosketa Backup-kuvaketta. Muuta 
varmuuskopiotiedoston nimeä koskettamalla sitä ja kirjoittamalla tilalle 
uusi nimi Backup selection -valintaikkunassa. Valitse Data selection -
valintaikkunassa, haluatko varmuuskopioida kaikki tiedot vai 
ainoastaan määrittämäsi tiedostotyypit. Kun haluat suojata 
varmuuskopiotiedoston salasanalla, kosketa Password protect -
kuvaketta, kirjoita käyttämäsi salasana kaksi kertaa ja kosketa OK-
kuvaketta.

Kun haluat palauttaa tietoja, valitse File manager > Tools > Back up/
Restore... ja kosketa Restore-kuvaketta. Valitse palautettava 
varmuuskopiotiedosto muistikortilta Restore selection 
-valintaikkunassa. Kosketa OK- ja Restore-kuvakkeita.

■ Tietokoneeseen liittäminen
Voit kytkeä laitteen yhteensopivaan tietokoneeseen laitteen mukana 
toimitetun Nokian DKE-2-liitäntäkaapelin (USB) avulla. Siirrä tiedostoja 
muistikortille käyttämällä USB-kaapelia.

Kun USB-kaapeli on liitettynä, Nokia 770 Internet Tablet -
kämmenselain näkyy tietokoneen luettelossa massamuistilaitteena ja 
laitteessa näkyy -kuvake. 

Kun USB-kaapeli on liitettynä, et voi käyttää muistikortilla olevia tietoja 
laitteen avulla. Voit kuitenkin siirtää tiedostoja tietokoneesta 
muistikortille ja katsoa muistikortin sisältöä tietokoneen avulla.
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Tärkeää: Älä poista USB-kaapelia minkään kaapelia käyttävän 
toiminnon aikana. Kaapelin poistaminen kesken toiminnon voi 
vahingoittaa muistikorttia ja laitetta, ja kaapelille tallennetut 
tiedot voivat vioittua. 

Kun lopetat tiedostojen siirtämisen, älä pelkästään irrota USB-
kaapelia tietokoneesta, vaan irrota laite tietokoneesta 
noudattamalla asianmukaisia ohjeita. Lisätietoja on 
tietokoneen käyttöoppaassa.

11.  Tietoa akuista

■ Lataaminen ja purkaminen
Laite saa virtansa uudelleenladattavasta akusta. Uuden akun täysi 
suorituskyky saavutetaan vasta kahden tai kolmen täydellisen lataus- ja 
purkukerran jälkeen. Akku voidaan ladata ja purkaa satoja kertoja, 
mutta lopulta se kuluu loppuun. Kun toiminta- ja valmiusajat ovat 
huomattavasti tavallista lyhyempiä, vaihda akku. Käytä vain Nokian 
hyväksymiä akkuja ja lataa akku vain Nokian hyväksymillä latureilla, 
jotka on tarkoitettu tätä laitetta varten.

Jos vaihtoakkua käytetään ensimmäisen kerran tai jos sitä ei ole 
käytetty pitkään aikaan, voi olla tarpeen kytkeä laturi laitteeseen, 
irrottaa se ja aloittaa lataus kytkemällä se uudelleen laitteeseen.

Irrota laturi seinäpistorasiasta ja laitteesta, kun laturia ei käytetä. Älä 
jätä täyteen ladattua akkua kytketyksi laturiin, koska ylilataaminen voi 
lyhentää sen käyttöikää. Jos täyteen ladattua akkua ei käytetä, lataus 
purkautuu itsestään ajan myötä.

Jos akku on täysin tyhjä, voi kestää joitakin minuutteja, ennen kuin akun 
latauksen symboli tulee näyttöön. 

Käytä akkua vain siihen tarkoitukseen, mihin se on suunniteltu. Älä 
koskaan käytä vahingoittunutta laturia tai akkua.

Vältä aiheuttamasta akun oikosulkua. Oikosulku voi aiheutua jonkin 
metalliesineen, kuten kolikon, paperiliittimen tai kynän, suorasta 
kosketuksesta akun positiivisen (+) ja negatiivisen (-) liitinnavan kanssa. 
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(Navat ovat metalliliuskojen kaltaisia osia akussa.) Näin voi tapahtua 
esimerkiksi silloin, kun vara-akku on taskussa tai laukussa. Liitinnapojen 
joutuminen oikosulkuun voi vahingoittaa akkua tai oikosulun 
aiheuttavaa esinettä.

Akun jättäminen kuumaan tai kylmään paikkaan, esimerkiksi suljettuun 
autoon kesäkuumalla tai pakkasella, vähentää akun tehoa ja käyttöikää. 
Pyri aina pitämään akku +15 °C:n ja +25 °C:n välisessä lämpötilassa. 
Laite, jossa on kuuma tai kylmä akku, ei ehkä tilapäisesti toimi 
huolimatta siitä, että akku on täyteen ladattu. Akkujen toimintakyky on 
erityisen alhainen reilusti alle 0 °C:n lämpötiloissa.

Älä heitä akkuja tuleen, koska ne voivat räjähtää. Myös vahingoittunut 
akku voi räjähtää. Hävitä akut paikallisten määräysten mukaisesti. Jos 
mahdollista, kierrätä ne. Akkuja ei saa heittää talousjätteen sekaan.

■ Ohjeet Nokian akun tunnistamista varten
Käytä aina alkuperäisiä Nokian akkuja turvallisuutesi vuoksi. Jotta voisit 
varmistaa, että saat alkuperäisen Nokian akun, osta se valtuutetulta 
Nokian jälleenmyyjältä, etsi pakkauksesta Nokia Original Enhancements 
-logo ja tarkasta hologrammitarra seuraavasti:

Tämän nelivaiheisen tarkastuksen onnistuminen ei anna täydellistä 
varmuutta akun aitoudesta. Jos sinulla on syytä epäillä, että akku ei ole 
aito Nokian alkuperäinen akku, älä ota sitä käyttöön vaan toimita se 
lähimpään valtuutettuun Nokian huoltopisteeseen tai valtuutetulle 
jälleenmyyjälle. Valtuutettu Nokian huoltopiste tai jälleenmyyjä tutkii 
akun aitouden. Jos aitoutta ei pystytä varmistamaan, palauta akku 
ostopaikkaan. 

Hologrammin aitouden varmistaminen
1. Kun katsot hologrammitarraa, sinun pitäisi 
nähdä yhdestä kulmasta Nokian symboli, 
jossa kädet kurottuvat toisiaan kohti, ja 
toisesta kulmasta Nokia Original 
Enhancements -logo.
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2. Kun käännät hologrammia vasemmalle, 
oikealle, alas ja ylös, sinun pitäisi nähdä 1, 2, 
3 ja 4 pistettä logon eri sivuilla.

3. Raaputa tarran reunaa. Esiin tulee 
20-numeroinen koodi, esimerkiksi 
12345678919876543210.  Käännä akkua 
niin, että numerot ovat oikeinpäin. 
20-numeroinen koodi alkaa ylärivillä 
olevasta numerosta ja jatkuu alariville.

4. Varmista 20-numeroisen koodin aitous 
noudattamalla osoitteessa www.nokia.com/
batterycheck annettuja ohjeita.

Voit tarkastaa aitouden tekstiviestillä: näppäile 20-numeroinen koodi 
(esimerkiksi 12345678919876543210) ja lähetä se numeroon +44 7786 
200276.

Aitouden tarkastus tekstiviestillä:

• Aasian ja Tyynenmeren alueen maat (Intiaa lukuun ottamatta): 
Näppäile 20-numeroinen koodi (esimerkiksi 
12345678919876543210 ja lähetä se numeroon +61 427151515.

• Intia: Näppäile sana Battery ja 20-numeroinen akkukoodi, 
esimerkiksi Battery 12345678919876543210 ja lähetä se numeroon 
5555.

Viestistä veloitetaan koti- ja ulkomaan operaattorimaksut.

Saat viestin, josta selviää, onko koodin aitous varmistettu.
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Entä jos akku ei ole aito?

Jos et pysty varmistamaan, että hankkimasi Nokian akku, jossa on 
hologrammitarra, on aito Nokian akku, älä ota akkua käyttöön. Toimita 
se lähimpään valtuutettuun Nokian huoltopisteeseen tai valtuutetulle 
jälleenmyyjälle. Sellaisen akun käyttäminen, joka ei ole valmistajan 
hyväksymä, voi olla vaarallista, heikentää laitteen ja sen lisälaitteiden 
suorituskykyä ja vahingoittaa niitä. Se voi myös mitätöidä laitetta 
koskevan hyväksynnän tai takuun.

Lisätietoja alkuperäisistä Nokian akuista on osoitteessa 
www.nokia.com/battery. 

Huolto-ohjeita

Laitteesi on korkeatasoinen laatutuote ja sitä tulee käsitellä huolellisesti. 
Seuraavat ohjeet auttavat sinua ylläpitämään takuusuojasi.

• Pidä laite kuivana. Sade, kosteus ja nesteet voivat sisältää mineraaleja, jotka 
syövyttävät elektronisia piirejä. Jos laite kastuu, poista akku ja anna laitteen 
kuivua kokonaan, ennen kuin asetat akun takaisin paikalleen.

• Älä käytä tai säilytä laitetta pölyisessä tai likaisessa paikassa. Sen liikkuvat 
osat ja elektroniset komponentit voivat vahingoittua.

• Älä säilytä laitetta kuumassa paikassa. Korkeat lämpötilat voivat lyhentää 
elektronisten laitteiden ikää, vahingoittaa akkuja ja taivuttaa tai sulattaa 
tiettyjä muoveja.

• Älä säilytä laitetta kylmässä paikassa. Kun laitteen lämpötila palautuu 
normaaliksi, sen sisälle voi muodostua kosteutta, joka saattaa vahingoittaa 
elektronisia piirilevyjä.

• Älä yritä avata laitetta muulla tavoin kuin tässä oppaassa annettujen 
ohjeiden mukaisesti.

• Älä pudota, kolhi tai ravista laitetta. Kovakourainen käsittely voi vahingoittaa 
sisällä olevia piirilevyjä ja hienomekaanisia osia.

• Älä käytä vahvoja kemikaaleja, liuottimia tai puhdistusaineita laitteen 
puhdistukseen.

• Älä maalaa laitetta. Maali voi tukkia sen liikkuvat osat ja estää sitä 
toimimasta kunnolla.

• Käytä latureita sisällä.
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• Tee säilytettävistä tiedoista (kuten yhteystiedoista ja kalenterimerkinnöistä) 
aina varmuuskopiot, ennen kuin lähetät laitteen huoltoon.

Kaikki edellä esitetyt ohjeet koskevat laitetta, akkua, laturia ja lisälaitteita. Jos 
jokin laite ei toimi kunnolla, vie se lähimpään valtuutettuun huoltoliikkeeseen.

Turvallisuutta koskevia lisätietoja

Laite ja sen lisälaitteet voivat sisältää pieniä osia. Pidä ne poissa pienten lasten 
ulottuvilta.

■ Käyttöympäristö
Muista noudattaa paikallisia määräyksiä ja katkaise virta laitteesta aina, kun 
laitteen käyttö on kielletty tai kun se saattaa aiheuttaa häiriöitä tai 
vaaratilanteen. 

Käytä laitetta vain sen normaaleissa käyttöasennoissa. Tämä laite täyttää 
radiotaajuusaltistumista koskevat suositukset, kun sitä käytetään normaalissa 
käyttöasennossa korvaa vasten tai siten, että sen etäisyys kehosta on vähintään 
1,0 cm. Kun käytetään suojalaukkua, vyöpidikettä tai muuta pidikettä, se ei saa 
sisältää metallia ja sen tulee asettaa laite siten, että se on edellä mainitulla 
etäisyydellä kehosta. 

Datatiedostojen tai viestien siirto tällä laitteella edellyttää hyvälaatuista 
yhteyttä verkkoon. Joissakin tapauksissa datatiedostot tai viestit siirretään vasta, 
kun tällainen yhteys on käytettävissä. Varmista, että edellä esitettyjä etäisyyttä 
koskevia ohjeita noudatetaan, kunnes tiedonsiirto on päättynyt.
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Tuote on seuraavien standardien mukainen:

EN 300328-2, Harmonisoitu standardi datansiirtolaitteille, jotka toimivat 2,4 
GHz ISM -kaistalla.

EN 50360, Tuotestandardi matkapuhelimien vaatimustenmukaisuuden 
osoittamisesta perusrajoituksiin koskien ihmisen altistumista 
sähkömagneettisille kentille.

EN 301 489-01, Sähkömagneettinen yhteensopivuusstandardi radiolaitteille ja 
järjestelmille.

EN 301 489-17, Erityisehdot (EMC) laajakaistaisen datansiirron ja HIPERLAN 
laitteille.

EN 60950/IEC950, Tietotekniikan laitteiden turvallisuus.

1999/5/EY, Neuvoston suositus väestön altistumisen rajoittamisesta 
sähkömagneettisille kentille. 

Tarkista yhteensopivuus muiden standardien kanssa erikseen.
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Open source software notice

This product includes certain open source software originating from third parties, 
which is subject to different and/or additional copyright licenses, disclaimers, 
acknowledgements, and notices. The source code of such open source software and 
the exact terms of said licenses, disclaimers, acknowledgements, and notices are 
reproduced and are available at www.nokia.com/support/770. 
This product includes certain software originating from third parties that is subject to 
1. the GNU Library/Lesser General Public License (LGPL), and 2. the GNU General Public 
License (GPL). The LGPL, GPL and said certain other licenses are available at 
www.nokia.com/support/770. You may obtain a complete corresponding machine-
readable copy of the source code of such software under the LGPL and the GPL at 
www.nokia.com/support/770. Alternatively, Nokia offers to provide such source code 
to you on CD-ROM for a charge covering the cost of performing such distribution, such 
as the cost of media, shipping, and handling, upon written request to Nokia at: 

Source Code Requests 
Multimedia 
Nokia Corporation 
P.O.Box 407 
FIN-00045 Nokia Group

This offer is valid for a period of three (3) years from the date of the distribution of this 
product by Nokia. Please refer to the exact terms of the LGPL and the GPL regarding 
your rights under said licenses.
This software is based in part on the work of the Independent JPEG Group.
The Graphics Interchange Format© is the Copyright property of CompuServe 
Incorporated. GIF SM is a Service Mark property of CompuServe Incorporated.
This product includes software developed by:
• Computing Services at Carnegie Mellon University 

(http://www.cmu.edu/computing/)
• Tommi Komulainen <Tommi.Komulainen@iki.fi>

The Australian National University
• The OpenSSL Project for use in the OpenSSL Toolkit 

(http://www.openssl.org/)
• Gregory M. Christy
• Pedro Roque Marques
• Eric Rosenquist, Strata Software Limited
• The XFree86 Project, Inc (http://www.xfree86.org/) and its contributors
• FreeType Team.
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